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What's New in CA ERwin Data Modeler? 
The following is a list of the new features in CA ERwin Data Modeler (CA ERwin DM) r7.3, 
including a brief description about each feature.  

Teradata Support  
Extensive support has been added for Teradata Version 2.6.x and Version 12. You can 
access new features in the property editors from the Database menu or from the Model 
Explorer. Complete Compare, Reverse Engineering and Forward Engineering 
functionality has been updated to support the new properties. 

Model Validation for Teradata  
A full suite of check model validation routines has been added for Teradata. 

ODBC-Based Metadata Access and SQL Query Features  
New features include a tool for working with SQL queries and an option to activate an 
ODBC-based driver within CA ERwin Data Modeler to enable query access from third-
party reporting tools. 
The Query Tool 
The Query Tool provides an easy way to execute SQL SELECT queries against the 
model or against a database catalog. You can execute a query against the objects and 
properties in the model, the metadata defining those objects and properties, and the action 
log that records the changes that are made to your model during the modeling session. 
You can create new queries or paste text from another source (such as a *.sql file) into a 
query. 
You can save a query to a *.qry file for later execution. Query results can be saved to a 
*.csv (comma-separated values) file. 
Although the Query Tool provides a built-in query interface in CA ERwin Data Modeler, 
you can also use any third-party reporting tool that has ODBC capability to query CA 
ERwin Data Modeler modeling data. 
ODBC Driver Activation 
CA ERwin Data Modeler r7.3 allows you to use any third-party reporting tool that has 
ODBC capability to query CA ERwin Data Modeler metadata. For example, you can use 
queries you created in Excel, Access, Crystal Reports, and Cognos and run them against 
the CA ERwin Data Modeler metadata. At this time only query syntax (SELECT 
statements) is supported. 
To enable this functionality, you activate the read-only ODBC-based driver provided 
with CA ERwin Data Modeler on the Integrations tab of the Options menu. This feature 
enables open access to the modeling metadata for reporting purposes. 
This new feature lets you query one model at a time (the current model). Although you 
cannot query a model in CA ERwin Model Manager, you can query an open model from 
a mart, if it is the current model. 
Crystal Reports 2008 
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A licensed copy of Business Objects™ Crystal Reports® is provided with each copy of 
CA ERwin Data Modeler. You can install your copy when you install or upgrade CA 
ERwin Data Modeler. Sample reports are also installed to the \ODBC Reports folder to 
help you get started. 

The Template Editor  
The Forward Engineer wizard now includes a link to a Template Editor that you can use 
to view, modify, and create new template files (*.fet) for use with schema generation. 
The Template Editor features give you a wide range of options for controlling schema 
generation for your models. You can review and print database-specific features of the 
default template files, create a custom template file based on a default template file, or 
create a completely new template file. All of the currently supported CA ERwin Data 
Modeler macros are available in the Template Editor, along with online documentation 
and customization options. 

Universal File Close Dialog  
A "universal" File Close dialog replaces the different Close dialogs in earlier releases to 
ensure a standardized look and feel throughout the product. 

Enhancements to Open or Save a Model in XML Format  
Changes have been implemented to let you save an XML file in one dialog. In earlier 
versions of the software, you needed to go through several dialogs to choose the proper 
XML format. When you select Save As from the File menu, you can select from among 
three different XML format options. 

Complete Compare Enhancements  
Optimization with CA ERwin Model Manager for "Three Way Merge" 
New features have been added to maximize performance when working with CA ERwin 
Model Manager models and Complete Compare. You can choose from two new options 
on the Model Manager tab of the Options dialog (Tools menu). You can select to skip the 
Difference Reconciliation dialog if no conflicts are detected between the version of the 
model in the mart and the local version, or select to display all objects. 
Advanced Options Added 
New options have been added to the Advanced pane of the Complete Compare wizard: 
Auto-Resolve Missing UDPs 
In some cases, the Type Resolution box appears when Complete Compare detects 
missing UDPs or property differences for common UDPs. You can select to skip the 
Type Resolution popup box when all the differences are due to missing UDPs. When you 
select this check box, all missing UDPs are automatically copied to the target model. 
Display Unified Attributes 
Select this check box to simplify the display of foreign-key attributes in the Resolve 
Differences dialog. When selected, a Unified Attributes group object is used to display all 
unified attributes (role-named or not) of the same unified set of attributes.  



 

16843 Harbour Town Drive 
Silver Spring MD 20905 

301-476-9190 

 
 

http://www.myriadinc.net Page 3 
 

Any attributes that are aligned to the attributes under the Unified Group object appear as 
part of the Unified Group object, even if they are not unified attributes. 
The Unified Attributes group object carries the unified name if all the attributes under it 
are part of the same unified set. If not, the name consists of a comma-delimited list of 
names of all the attributes under it. 
Select Active Subject Area 
Specifies that you want to select the active subject area by default in the Object Selection 
pane. This simplifies the subject area selection, especially in models that contain a large 
number of subject areas. 
Ignore Code Comments 
Select this option to exclude blocks of comments from the body of a trigger, before 
including it in the compare process. This enables Complete Compare to recognize that a 
trigger has not changed, if the only difference is in the comment text attached to the 
trigger. 
Exclude Unaligned Objects/Display Only Aligned Objects 
Two features on the Advanced Options pane of the Complete Compare wizard enable 
you to exclude unaligned model-level objects in either the left or right model. They are 
"Exclude Unaligned Objects in the Left Model" and "Exclude Unaligned Objects in the 
Right Model". In earlier versions of the product, these options were mutually exclusive - 
you could not select both. In CA ERwin Data Modeler r7.3 you can now select both 
check boxes to display only aligned model-level objects in the Resolve Differences 
dialog. These features are useful when you work with a submodel or subject area of a 
larger model, and then want to compare changes against the larger model. When you 
select the "Exclude Unaligned Objects..." check box for the larger model, you exclude the 
model-level unaligned objects from the Resolve Differences dialog display. This results 
in a more relevant list of differences and a display that is easier to read. 
Type Resolution Wizard 
In earlier versions of CA ERwin Data Modeler when the type signatures of the two 
models were not identical, a popup window displayed, enabling you to review and accept 
the choices for missing types or type conflicts. In CA ERwin Data Modeler r7.3 this 
popup dialog has been replaced with a wizard. The wizard makes it easier to navigate and 
use the available options. 
Demand Loading Enhancement 
When working with a database in Complete Compare, selecting the Allow Demand 
Loading check box enables you load only the names of the top-level objects from the 
database catalog. When you perform an action on a partially loaded object in the Resolve 
Difference dialog, it is fully loaded in order to complete the compare action. In CA 
ERwin Data Modeler r7.3, demand loading has been optimized to improve overall 
performance. 
Demand Loading and DB Sync 
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To optimize performance when doing a DB Sync, the Demand Loading option is now 
activated by default. In earlier versions, the check box (on the Right Model pane of the 
DB Sync wizard) was selected by default, but could be changed. In r7.3 you cannot clear 
this check box. 
Object Selection Enhancement 
When a model contains a large number of objects it may be difficult to locate the objects 
that have been selected in the Right and Left Object Selection panes of the Complete 
Compare wizard. For example, if you select a Subject Area set, it may be difficult to 
locate the selected objects in the list. A check box with the label "Hide Unselected 
Objects" has been added to the Object Selection panes. Select the check box to remove 
unselected objects from the Selected Objects display. This change also applies to the DB 
Sync Wizard. 
Range Selection Enhancement 
Range selection functionality has been added to the Object Selection panes in Complete 
Compare. You can now select a range of items on the same level using 
SHIFT+LEFTCLICK, or select individual items using CTRL+LEFTCLICK. For 
example, you can use SHIFT+LEFTCLICK to select a range of Entities in the "Selected 
Objects" list, then clear one check box next to an entity name to clear the check boxes for 
all the selected entities. In earlier versions of the product, it was necessary to select or 
clear each check box individually. 
Change to Type Selection Filtering 
In earlier versions of CA ERwin Data Modeler type selection in the Complete Compare 
wizard resulted in hiding the selected item from the user, not strictly removing the object 
from the compare process. This resulted in no performance improvement for type 
filtering. In CA ERwin Data Modeler r7.3 type selection has been updated so that 
filtering is applied strictly according to the choices made in the Type Selection pane of 
the Complete Compare wizard. 
"Explain" Button Added 
To improve performance and to make compare results displayed in the Resolve 
Differences dialog easier to understand, a new "Explain" button has been added to the 
Resolve Differences dialog. When you click the Explain button, an Explanation dialog 
opens. For object rows, the text explains why the two objects were aligned. For property 
rows, the text explains why the two property values are equal. The "Explain" button 
replaces the "Details" button available in earlier versions of the product. 

Enhancements to Triggers  
Changes have been implemented to allow you to create model objects for ERwin-
generated triggers. In earlier versions of the software, triggers did not exist as objects in 
the model, they were created during the forward-engineering process but not recognized 
during reverse-engineering. 
In CA ERwin DM r7.3, several features have been implemented to allow you to treat 
triggers as model objects. These enhancements allow you include the triggers in alter 
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scripts, include triggers in Complete Compare scenarios, and associate triggers with 
model templates. 
The RI Defaults tab on the Model Properties dialog now includes a check box with the 
label "Automatically Create RI Triggers." When you select this check box, you are 
prompted with an option to create RI triggers for existing relationships. The option is 
then enabled for new objects. If you click No to the prompt, RI Triggers are created only 
for new relationships. This check box is not selected by default - you must select it to 
activate this new feature. 
In the Forward Engineer wizard, on the Options tab for the Triggers object, the wording 
of the triggers options has been updated to reflect the new distinction between ERwin-
generated and User-Defined triggers. When you select to automatically generate RI 
triggers, a check box is provided with the label "Automatically Generate Missing RI 
Triggers." 
The Reverse Engineer - Set Options dialog now includes a check box with the label 
"Include Generated Triggers." You select this check box to include RI Triggers in the 
reverse engineer process. 

Macro Enhancements  
This release introduces CA ERwin Data Modeler's Template Language (TLX), the new 
template/macro language for Forward Engineering templates. The macros available in 
earlier versions of CA ERwin Data Modeler are still accessible using the Macro Toolbox 
that you can open from the Domain Dictionary dialog, Model Naming Options dialog, 
Pre and Post Scripts dialog, Triggers dialog, and so on.  
For macros you can use in Forward Engineering Templates, a technical document, the 
Template Language and Macro Reference PDF is installed with the product in the \Doc 
folder beneath the folder where you installed CA ERwin Data Modeler. This guide 
provides extensive technical documentation for the Forward Engineering Template 
macros. You can open help for an individual macro when you right-click the macro name 
in the Macros pane of the Template Editor. 

Updates to Database Support List and Supported Operating Systems  
Support has been added for the following target server databases: 

Oracle 11x  
Teradata 2.6. 12/13  
SQL Server 2008 

Support has been dropped for the following target server databases or operating systems: 
Ingres 2.5  
Oracle 8i  
Progress 8.x  
SQL Server 7.0  
Windows 2000 

Support has been added for the following operating systems: 
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Microsoft Vista  
Microsoft Visual Studio 2008 Team Edition for Database Professionals (for 

integration with CA ERwin Data Modeler) 
Metadata Integration (MITI) Bridges Updated  

The list of supported Metadata Integration Bridges from Meta Integration Technology, 
Inc. (MIMB) has been updated. You can access the bridges when you click Import, From 
External Format or Export, To External Format on the File menu. 
The full list of supported import and export bridges is documented in Appendix B of the 
CA ERwin Data Modeler Implementation Guide. This PDF guide is available from the 
Start menu, or in the \Doc folder where you installed the product. 

Metamodel Reference Documentation  
A new reference document, ERwin Metamodel Reference has been produced that 
provides a comprehensive list of the CA ERwin Data Modeler metadata object classes, 
property classes, aggregations, and associations. The document is in PDF format and can 
be opened from a shortcut on the Start menu. A copy is also installed to the \Doc folder 
where you installed the product. 

Implementation of Compiled HTML Help (CHM)  
Online help for all products in the modeling suite is now provided in Compiled HTML 
(CHM) format. This replaces Windows Help (HLP) format provided in earlier versions. 
The CHM help modules include full search capability, indexing, and a comprehensive 
table of contents. You can click the help button or press F1 in any program context and 
the online help file opens to the topic relevant to the feature you are using. The table of 
contents and topics are also synchronized, so that the topic opens the table of contents 
tree to the appropriate location at the same time it displays the help topic. 

Documentation Bookshelf  
The Documentation Bookshelf is an HTML-based reference tool that provides easy 
access to the online help and core reference documentation for CA ERwin Data Modeler 
and CA ERwin Model Manager. The Bookshelf provides a "front end" user interface 
where you can open individual PDF Guides or online help files, or search a combined 
index for all deliverables. 
The bookshelf is installed by default with the product and is available from the Start 
menu. 
A zip file containing the Bookshelf is also provided as a download from the Technical 
Support page of CA Support Online at http://support.ca.com. 
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